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MỘT SỐ THỦ THUẬT TRONG WORD 2010 
 

BÀI 1: 

Để tiết kiệm thời gian và công sức khi nhập nội dung cho một văn bản lớn trong đó có sự lặp lại 

nhiều lần một hay nhiều nhóm từ, bạn có thể thiết lập chức năng AutoCorrect nhằm thay thế một 

vài ký tự viết tắt cho các từ đó bởi các từ đủ nghĩa mà thông thường các từ này dài hơn. 

1. Auto Correct và Macro 

a. Auto Correct 

Chọn biểu tượng Office 2010trên góc trái của của sổ Word, chọn Options, chọn Proofing, chọn 

Auto Correct Options. 

 

Hiển thị hộp thoại sau: 

 

http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-1.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-2.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-1.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-2.gif
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- Correct TWo INitian CApitals : nếu hai ký tự đầu tiên trong một từ được gõ bằng chữ in thì nó 

sẽ thay chữ in thứ hai bằng chữ thường. 

VD: gõ TWo INitian CApitals sẽ được thay bằng Two Initian Capitals. 

- Capitalize first letter of sentences : Word nhận biết sau dấu chấm sẽ bắt đầu một câu mới và ký 

tự đầu câu sẽ được đổi thành chữ in nếu chúng ta gõ bằng chữ thường. 

- Capitalize name of days : Ký tự đấu tiên của thứ (ngày trong tuần được gõ bằng tiếng Anh) sẽ 

đổi thành chữ in. 

- Correct accidental usage of cAPS LOCK key : khi gõ phím Caps Lock, đèn Caps Lock trên bàn 

phím sáng, lúc này chúng ta có thể gõ nhầm trạng thái của bàn phím bằng cách giữ phím Shift gõ 

ký tự đầu tiên của một từ, sau đó nhả phím Shift gõ các ký tự còn lại của từ, sau khi gõ xong từ 

này Word sẽ đổi từ đã gõ về đúng dạng đồng thời làm tắt luôn đèn caps lock. 

- Replace text as you type : tự động gõ từ sai thành từ đúng. 

Trong hộp thoại trên, từ sai được liệt kê ở bên cột trái tương ứng với từ đúng ở bên cột phải. Như 

vậy chỉ khi nào gõ đúng từ sai ở bên trái thì Word sẽ tự động thay thế từ đúng ở bên phải. 

Nhập nội dung viết tắt vào hộp Replace. Nhập nội dung thay thế cho nội dung viết tắt vào hộp 

With, sau đó click nút Add để đưa vào danh sách AutoCorrect. 

Thực hiện tuần tự các bước để nhập thêm các từ viết tắt khác. Khi thực hiện xong, nhấn OK để 

thoát khỏi hộp thoại. 

Muốn xoá từ viết tắt nào, bạn click chọn từ trong danh sách và nhấn Delete. 

Muốn sửa đổi, chọn từ trong danh sách và nhập lại vào nội dung trong khung Replace hoặc With. 

Trong khi gõ văn bản, muốn sử dụng AutoCorrect bạn nhập vào từ viết tắt, sau đó nhập thêm dấu 

phân cách từ (ký tự trắng, dấu phẩy, dấu chấm, dấu chấm hỏi, . . .) để đưa nội dung thay thế 

tương ứng vào văn bản. 

b. Macro 

Macros là các tính năng ti n tiến, có thể làm tăng tốc độ hiệu chỉnh hay định dạng mà bạn có thể 

thực thi thường xuyên trong một tài liệu Word. Chúng ghi lại chuỗi các lựa chọn mà bạn chọn để 

cho một loạt các hành động cụ thể được hoàn thành trong một bước. 

Ghi một Macro  

Để ghi một Macro: 

♦ Chọn tab View trên vùng Ribbon. 
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♦ Chọn vào mũi tên phía dưới Macros. 

 

♦ Chọn Record Macro, hộp thoại xuất hiện như sau: 

 

♦ Nhập tên (không chứa dấu cách). 

♦ Chọn vào nơi bạn muốn gán cho một nút (trên Quick Access Toolbar) hay bàn phím (chuỗi các 

phím). 

♦ Để gán Macro cho một nút trên Quick Access Toolbar: 

- Chọn Button. 

http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-3.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-4.gif
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- Dưới Customize Quick Access Toolbar, lựa chọn tài liệu mà bạn muốn Macro có sẵn. 

 

- Dưới lệnh chọn: Chọn Macro mà bạn đang ghi. 

- Chọn Add. 

- Chọn OK để bắt đầu ghi Macro. 

- Thực thi các hành động bạn muốn được ghi trong Macro. 

- Chọn Macros. 

- Chọn vào Stop Recording Macros. 

 

♦ Để gán một nút Macro cho một phím tắt:  

- Ở hôp thoại Record Macro, Chọn Keyboard. 

- Trong hộp Press New Shortcut Key, nhập phím tắt mà bạn muốn gán cho nút Macro và Chọn 

http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-5.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-6.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-5.gif
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Assign. 

 

- Chọn Close để bắt đầu ghi Macro. 

- Thực thi các hành động bạn muốn được ghi trong Macro. 

- Chọn Macros. 

- Chọn Stop Recording Macros. 

Chạy Macro 

Chạy một Macro phụ thuộc vào nơi nó được thêm vào Quick Access Toolbar hay nếu nó được 

gán là một phím tắt. 

♦ Để chạy một Macro từ Quick Access Toolbar, Chọn vào biểu tượng Macro. 

 

♦ Để chạy một Macro từ phím tắt, chỉ cần ấn các phím mà bạn đã lập trình để chạy Macro. 

 

 

 

 

 

http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-7.gif
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http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-9.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-7.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/mot-so-thu-thuat-trong-word-2010-8.gif
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BÀI 2: 

 
Bạn có thể nhanh chóng chọn tab bằng cách lần lượt nhấn vào ô tab selector – là ô giao nhau 

giữa thước dọc và thước ngang (ở góc trên bên trái trang tài liệu) cho đến khi chọn được kiểu tab 

mong muốn, sau đó nhấn chuột vào thanh thước ngang nơi bạn muốn đặt tab. 

 

Thay đổi khoảng cách trước hoặc sau các đoạn 

1. Chọn đoạn văn bản bạn muốn thay đổi khoảng cách trước hoặc sau nó. 

2. Trong thẻ Page Layout, nhóm Paragraph, bạn nhấn chuột vào mũi tên cạnh mục Before (trước) 

hoặc After (sau) để thay đổi bằng giá trị bạn muốn. 

Thay đổi khoảng cách giữa các ký tự 

1. Chọn đoạn văn bản mà bạn muốn thay đổi. 

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font để mở hộp thoại 

Font. 

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Trong mục Spacing, nhấn Expanded để mở 

rộng hay Condensed để thu hẹp khoảng cách và chỉ định số khoảng cách trong mục By. 

 

  

Co dãn văn bản theo chiều ngang 

1. Chọn đoạn văn bản bạn muốn căng ra hoặc thu lại. 

2. Trong thẻ Home, nhấn chuột vào nút mũi tên ở góc dưới phải của nhóm Font để mở hộp thoại 

Font. 

3. Nhấn chọn thẻ Character Spacing ở hộp thoại này. Tại mục Scale, nhập vào tỉ lệ % mà bạn 

muốn. Nếu tỉ lệ này lớn hơn 100% thì đoạn văn bản sẽ được kéo ra, ngược lại, nó sẽ được thu lại. 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p2-1.gif
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Đánh dấu sự thay đổi và ghi chú trong tài liệu 

Theo dõi sự thay đổi trong khi chỉnh sửa 

1. Mở tài liệu mà bạn muốn theo dõi. 

2. Trong thẻ Review, nhóm Tracking, nhấn nút Track Changes. 

3. Thay đổi tài liệu theo ý bạn (chèn, xóa, di chuyển hay định dạng văn bản…). Lập tức ở bên 

hông trang tài liệu sẽ xuất hiện những bong bóng hiển thị sự thay đổi này. 

Tắt chế độ theo dõi sự thay đổi 

Trong thẻ Review, nhóm Tracking, nhấn vào nút Track Changes một lần nữa để tắt chế độ theo 

dõi trong khi chỉnh sửa. 

Thay đổi cách Word đánh dấu 

- Bạn có thể đổi màu và những định dạng mà Word dùng để đánh dấu sự đổi trong tài liệu bằng 

cách nhấn vào mũi tên bên cạnh nút Track Changes, và nhấn chọn mục Change Tracking 

Options. 

  

- Nếu bạn muốn xem tất cả những thay đổi ngay trong tài liệu thay vì hiển thị những bong bóng 

bên hông tài liệu, ở nhóm Tracking, nhấn vào nút Ballons, sau đó chọn Show all revisions inline. 

- Để làm nổi bật vùng hiển thị những bong bóng (bên lề tài liệu), hãy nhấn nút Show Markup và 

chọn Markup Area Highlight. 

2. Định dạng cột, tab, Numbering 

a. Định dạng cột 

Cách thứ nhất: gõ văn bản trước, chia cột sau: 

- Bước 1: bạn nhập văn bản một cách bình thường, hết đoạn nào thì nhấn Enter để xuống hàng. 

Sau khi đã gõ hết nội dung văn bản, bạn hãy nhấn Enter để con trỏ xuống hàng tạo một khoảng 

trắng. 

- Bước 2: tô khối nội dung cần chọn (không tô khối dòng trắng ở trên), tại thẻ Page Layput, 

nhóm Page Setup bạn chọn các mẫu cột do Word mặc nhiên ấn định. 
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Nhấn vào More Columns hiển thị hộp thoại; 

 

  

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p2-3.gif
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- Presets : các mẫu chia cột 

- One – Two – Three : Các cột có độ rộng bằng nhau 

- Left – Right : Các cột có độ rộng khác nhau 

- Number of Columns : Số cột (nếu muốn số cột chữ ɯ) 

- Line Between: : Đường kẻ giữa các cột 

- Width and Spacing : Điều ch nh độ rộng và khoảng cách 

- Equal column width : Các cột có độ rộng cột bằng nhau nếu nhắp chọn vào ô vuông phía trước 

Cách thứ hai: chia cột trước, gõ văn bản sau (dùng trong trường hợp toàn bộ văn bản được chia 

theo dạng cột báo). 

- Tại thẻ Page Layput, nhóm Page Setup bạn chọn các mẫu cột do Word mặc nhiên ấn định 

- Nhập văn bản vào. 

- Tại thẻ Page Layput, nhóm Page Setup bạn chọn Breaks, Column Break: để ngắt cột khi bạn 

muốn sang các cột còn lại. 
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b. Cài đặt điểm dừng tab (Tab stops) 

Để cho việc cài đặt tab được thuận tiện, bạn nên cho hiển thị thước ngang trên đỉnh tài liệu bằng 

cách nhấn nút View Ruler ở đầu trên thanh cuộn dọc. 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p2-5.gif
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Bạn có thể nhanh chóng chọn tab bằng cách lần lượt nhấn vào ô tab selector – là ô giao nhau 

giữa thước dọc và thước ngang (ở góc trên bên trái trang tài liệu) cho đến khi chọn được kiểu tab 

mong muốn, sau đó nhấn chuột vào thanh thước ngang nơi bạn muốn đặt tab. 

Tùy từng trường hợp có thể mà bạn có thể sử dụng một trong các loại tab sau: 

♦ Tab trái: Đặt vị trí bắt đầu của đoạn text mà từ đó sẽ chạy sang phải khi bạn nhập liệu. 

♦ Tab giữa:Đặt vị trí chính giữa đoạn text. Đoạn text sẽ nằm giữa vị trí đặt tab khi bạn nhập liệu. 

♦ Tab phải: Nằ m ở bạn phải cuối đoạn text. Khi bạn nhập liệu, đoạn text sẽ di chuyển sang trái 

kể từ vị trí đặt tab. 

♦ Tab thập phân: Khi đặt tab này, những dấu chấm phân cách phần thập phân sẽ nằm trên cùng 

một vị trí. 

♦ Bar Tab: Loại tab này không định vị trí cho text. Nó sẽ chèn một thanh thẳng đứng tới vị trí 

đặt tab. 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p2-6.gif
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- Default tab stops: Khoảng cách dừng của default tab, thông thường là 0.5″ 

- Tab stop position: gõ tọa độ điểm dừng Tab. 

- Alignment: chọn một loại tab là Left – Center – Right – Decimal – Bar (loại tab chỉ có tác 

dụng tạo một đuờng kẻ dọc ở một tọa độ đã định). 

- Leader :chọn cách thể hiện tab. 

+ 1 None Tab tạo ra khoảng trắng. 

+ 2-3-4 Tab tạo ra là các dấu chấm, dấu gạch hoặc gạch liền nét. 

- Các nút lệnh: 

♦ Set : Đặt điểm dừng tab, tọa độ đã gõ được đưa vào danh sách. 

♦ Clear : xóa tọa độ đã chọn. 

♦ Clear all : xóa tất cả tọa độ điểm dừng tab đã đặt. 

Nếu bạn muốn đặt điểm dừng tab tại vị trí phù hợp mà không thể xác định chính xác khi nhấn 

chuột lên thanh thước ngang, hoặc bạn muốn chèn ký tự đặc biệt trước tab, bạn có thể dùng hộp 

thoại Tabs bằng cách nhấn đúp chuột vào bất kỳ điểm dừng tab nào trên thanh thước. 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p2-7.gif
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Sau khi cài đặt điểm dừng tab xong, bạn có thể nhấn phím Tab để nhảy đến từng điểm dừng 

trong tài liệu. 

 

 

BÀI 3: 

Để có thể tùy biến chữ cái nhấn mạnh này, bạn nhấn chuột lên lệnh Drop Cap Options trên menu 

của Drop Cap. Trên hộp thoại Drop Cap, bạn có thể chọn vị trí của chữ nhấn mạnh, font chữ, số 

dòng thả xuống và khoảng cách từ chữ nhấn mạnh tới cụm text. 

 

c. Numbering 

Số thứ tự tự động cho phép bạn định dạng và tổ chức văn bản với các số, các bullet (dấu chấm 

tròn). 
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Bulleted and Numbered 

Các danh sách Bullet có các dấu chấm tròn, danh sách các Number có các số và danh sách các 

Ountline là sự phối hợp giữa các số và các chữ cái phụ thuộc vào sự tổ chức của danh sách. 

Để thêm một thứ tự tự động vào văn bản có sẵn: 

♦ Lựa chọn văn bản bạn muốn để tạo một thứ tự tự động. 

♦ Trong nhóm Paragraph trên tab Home, kích vào nút danh sách Bulleted hoặc Numbered. 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p3-1.gif
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Để tạo một thứ tự tự động mới: 

♦ Đặt con trỏ vào nơi bạn muốn chèn thứ tự tự động trong tài liệu. 

♦ Chọn nút danh sách Bulleted hoặc Numbered. 

♦ Rồi nhập nội dung bình thường. 

Số thứ tự tự động lồng 

Số thứ tự tự động lồng là danh sách có một vài cấp độ. Để tạo một thứ tự tự động lồng: 

♦ Tạo thứ tự tự động của bạn theo sự hướng dẫn phía trên. 

♦ Chọn nút Increase Indent hay Decrease Indent. 

 

  

Định dạng danh sách thứ tự tự động 

Hình ảnh chấm tròn và số có thể được thay đổi bằng cách sử dụng hộp thoại Bullets or 

Numbering. 

♦ Lựa chọn toàn bộ thứ tự tự động để thay đổi tất cả các dấu chấm tròn hay số, hoặc đặt con trỏ 

lên một dòng trong danh sách thứ tự tự động để thay đổi một Bullet. 

♦ Chọn phải chuột. 

♦ Chọn vào mũi tên bên cạnh danh sách Bulleter hay Numbered và chọn một Bullet hay 

Numbering khác. 

  

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p3-2.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p3-3.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p3-2.gif
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3. Drop Cap 

Tạo một chữ hoa thụt cấp (Dropped Cap) 

Microsoft Word có tính năng tạo chữ nhấn mạnh gọi là Drop Cap. Đó là chữ cái đầu câu được 

phóng to và thả xuống. Kiểu trình bày văn bản này có tính mỹ thuật cao. 

Nhấp chuột lên tab Insert trên thanh Ribbon và chọn lệnh Drop Cap trong nhóm Text. Khi bạn 

nhấn lên nút lệnh Drop Cap, một menu xổ xuống xuất hiện. Bạn nhấn lên dòng Dropped lập tức 

mẫu tự đầu tiên của dòng đầu tiên trên văn bản sẽ được nhấn mạnh. 

 

Có 2 chế độ: 

1. Dropped cap. 

2. In-margin dropped cap. 

Để có thể tùy biến chữ cái nhấn mạnh này, bạn nhấn chuột lên lệnh Drop Cap Options trên menu 

của Drop Cap. Trên hộp thoại Drop Cap, bạn có thể chọn vị trí của chữ nhấn mạnh, font chữ, số 

dòng thả xuống và khoảng cách từ chữ nhấn mạnh tới cụm text. Nhấn OK để hoàn tất. 

http://bikipvanphong.info/tag/microsoft/
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Sau này, nếu không muốn nhấn mạnh kiểu Drop Cap nữa, bạn chỉ việc vào lại màn hình Drop 

Cap và chọn lệnh None là xong. 

4. Watermark (nền bảo vệ văn bản) 

Hình mờ 

Một hình mờ là một ảnh trong suốt mà xuất hiện ngay sau văn bản trong tài liệu. Để chèn một 

hình mờ: 

♦ Chọn tab Page Layout trên vùng Ribbon. 

♦ Chọn nút Watermark trong nhóm Page Background. 

♦ Kích chọn Watermark bạn muốn hoặc Chọn Custom Watermark và tạo một hình mờ riêng. 

♦ Để bỏ một hình mờ, thực hiện các bước như trên nhưng chọn Remove Watermark. 

  

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p3-6.gif
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5. Tạo tiêu đề trên và dưới (Header and Footer) cho văn bản 

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay Footer. 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p3-7.gif
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Một menu xổ xuống với các Header, Footer mẫu cho bạn chọn. Kế đến bạn nhập nội dung cho 

Header hay Footer đó. Nhập xong nhấn đúp chuột vào vùng nội dung của trang, lập tức Header/ 

Footer sẽ được áp dụng cho toàn bộ trang của tài liệu. 

Thay đổi Header / Footer cũ bằng Header / Footer mới 

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay Footer. Sau đó chọn 

lại một Header / Footer mới để thay cho Header / Footer hiện tại. 

 

 

 

 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-trong-van-ban-p3-8.gif


MỘT SỐ THỦ THUẬT TRONG WORD 2010 

20 

LÊ MINH BÍCH- Đ7QL6 

BÀI 4: ĐỊNH DẠNG VĂN BẢN TRONG WORD 2010 

 

Trong tài liệu, thường trang đầu tiên không được đánh số vì nó là trang bìa. Áp dụng phần ghi 

chú ở thủ thuật ―Bắt đầu đánh số trang bằng một số khác‖ bên trên, trang bìa vẫn được đánh số là 

0. Vì vậy bạn hãy thực hiện thêm bước sau để xóa hẳn số trang ở trang đầu tiên của tài liệu. 

 

Không sử dụng Header / Footer cho trang đầu tiên 

Tại thẻ Page Layout, bạn nhấn chuột vào nút góc dưới phải của nhóm Page Setup để mở hộp 

thoại Page Setup. Kế đến mở thẻ Layout ra. Đánh dấu kiểm mục Different first page bên dưới 

mục Headers and footers. Nhấn OK. 

 
Vậy là Header / Footer đã được loại bỏ khỏi trang đầu tiên của tài liệu. 

Trong Word 2003, bạn cũng có thể loại bỏ Header / Footer cho trang đầu tiên bằng cách vào 

menu File – Page Setup → chọn thẻ Layout → đánh dấu check Different first page → OK. 

Áp dụng Header / Footer khác nhau cho trang chẵn và trang ẻ 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-van-ban-trong-word-2010-11.gif
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Tại thẻ Page Layout, bạn nhấn chuột vào nút góc dưới phải của nhóm Page Setup để mở hộp 

thoại Page Setup. Kế đến mở thẻ Layout ra. Đánh dấu kiểm mục Different odd and even bên 

dưới mục Headers and footers. Nhấn OK. 

Bây giờ bạn có thể chèn Header / Footer cho các trang chẵn trên một trang chẵn bất kỳ, chèn 

Header / Footer cho các trang lẻ trên một trang lẻ bất kỳ. 

Trong Word 2003, bạn cũng có thể thực hiện tương tự bằng cách vào menu File – Page Setup → 

chọn thẻ Layout → đánh dấu check Different odd and even > OK. 

 
Thay đổi nội dung của Header / Footer 

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay Footer. Kế đến chọn 

Edit Header / Edit Footer trong menu xổ xuống để chỉnh sửa nội dung của Header / Footer. 

Trong khi chỉnh sửa bạn có thể định dạng lại font chữ, kiểu chữ, màu sắc… cho tiêu đề Header / 

Footer bằng cách chọn chữ và sử dụng thanh công cụ Mini xuất hiện bên cạnh. Chỉnh sửa xong 

bạn nhấn đúp chuột ra ngoài vùng nội dung của trang tài liệu. Xóa Header / Footer 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-van-ban-trong-word-2010-21.gif
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Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay Footer. Kế đến chọn 

Remove Header / Remove Footer trong danh sách xổ xuống. 

 
Tạo Header / Footer khác nhau cho các vùng khác nhau của tài liệu 

- Trước tiên, bạn cần tạo các ngắt vùng để phân chia các vùng trong tài liệu. Nhấn chuột vào vị 

trí muốn đặt một vùng mới. Trong thẻ Page Layout, nhóm Page Setup, nhấn nút Breaks và chọn 

một kiểu ngắt vùng phù hợp trong Section Breaks, ví dụ Continuous (chúng ta sẽ tìm hiểu kỹ hơn 

về ngắt trang / ngắt vùng ở những bài viết sau). 

  

- Tại thẻ Insert, nhóm Header & Footer, bạn nhấn chuột vào nút Header hay Footer. Kế đến chọn 

Edit Header / Edit Footer để chỉnh sửa nội dung cho Header / Footer. 

- Trên thẻ Header & Footer, nhóm Navigation, nếu thấy nút Link to Previous đang sáng thì nhấn 

vào nút này một lần nữa để ngắt kết nối giữa Header / Footer trong vùng mới này với vùng trước 

đó. Bạn sẽ thấy mục Same as Previous ở góc trên bên phải của Header / Footer biến mất. 

- Sau đó bạn chỉnh sửa Header / Footer cho vùng mới này và yên tâm rằng những Header / 

Footer của các vùng trước đó không bị thay đổi theo. 

6. Đánh số thứ tự cho trang văn bản Chèn số trang vào văn bản 

Số trang này sẽ được đưa vào Header hay Footer tùy ý bạn. Để thực hiện, bạn chọn thẻ Insert, tại 

nhóm Header & Footer, bạn nhấn nút Page Number. Trong menu xuất hiện, bạn trỏ tới Top of 

Page (chèn số trang vào phần Header) hoặc Bottom of Page (chèn vào Footer). Word 2010cung 

cấp sẵn khá nhiều mẫu đánh số trang và bạn chỉ việc chọn một trong các mẫu này là xong. 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-van-ban-trong-word-2010-31.gif
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Thay đổi dạng số trang 

Bạn có thể thay đổi dạng số trang theo ý thích của mình mà định dạng chuẩn không có sẵn. Để 

thực hiện, bạn nhấn đúp vào Header hay Footer, nơi bạn đã đặt số trang. Tại thẻ Design, nhóm 

Header & Footer, bạn nhấn nút Page Number, chọn tiếp Format Page Numbers. 

 
Number format: Chọn dạng số thứ tự. 

Include Chapter Number: Số trang sẽ được kèm với số chương. 

Continue From Previous Section: Số trang nối tiếp với section trước đó. 

Start at : Số trang được bắt đầu từ số. 

Trong hộp thoại Page Number, tại mục Number format, bạn hãy chọn một kiểu đánh số mình 

thích, sau đó nhấn OK. 

Thay đổi kiểu chữ, cỡ chữ, màu sắc của số trang 

Nhấn đúp chuột vào Header hay Footer, nơi bạn đã đặt số trang tại đó. 

http://bikipvanphong.info/wp-content/uploads/2012/07/dinh-dang-van-ban-trong-word-2010-51.gif
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Dùng chuột chọn số trang. Tại thanh công cụ mini vừa xuất hiện ở bên trên, bạn có thể chọn lại 

font chữ, cỡ chữ, định dạng lại chữ đậm, nghiêng, hay chọn màu tùy thích. Khi hiệu chỉnh xong 

bạn nhấn đúp chuột vào vùng nội dung chính của tài liệu. 

Bắt đầu đánh số trang bằng một số khác 

Bạn có thể bắt đầu đánh số trang bằng một con số khác, thay vì 1 như mặc định. Cách thực hiện: 

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn nút Page Number, chọn Format Page Numbers. 

Trong hộp thoại xuất hiện, bạn chọn Start at và nhập vào con số bắt đầu khi đánh số trang. Nhấn 

OK. 

Ghi chú: Nếu tài liệu của bạn có trang bìa và bạn muốn trang đầu tiên sau đó được bắt đầu bằng 

1, tại ô Start at, bạn hãy gõ vào 0. 

Xóa số trang đã đánh 

Tại thẻ Insert, nhóm Header & Footer, bạn nhấn nút Page Number, sau đó chọn Remove Page 

Numbers ở cuối menu. 

Xóa số trang ở trang đầu tiên của tài liệu 

Trong tài liệu, thường trang đầu tiên không được đánh số vì nó là trang bìa. Áp dụng phần ghi 

chú ở thủ thuật ―Bắt đầu đánh số trang bằng một số khác‖ bên trên, trang bìa vẫn được đánh số là 

0. Vì vậy bạn hãy thực hiện thêm bước sau để xóa hẳn số trang ở trang đầu tiên của tài liệu. 

- Nhấn chuột vào bất kỳ vùng nào của tài liệu. 

- Tại thẻ Page Layout, bạn nhấn chuột vào ô vuông góc dưới bên phải của nhóm Page Setup để 

mở hộp thoại Page Setup ra. 

- Nhấn chuột vào thẻ Layout trong hộp thoại, bên dưới Headers and footers, bạn đánh dấu chọn 

vào hộp kiểm Different first page. Nhấn OK. 

Bây giờ bạn hãy kiểm tra lại xem, có đúng là trang đầu tiên không có số trang, sau đó trang kế 

được đánh số 1 không nhé. 
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BÀI 5 

Khi có hòm thư e-mail do một máy chủ hỗ trợ (theo giao thức IMAP hoặc POP3), bạn có thể 

dùng Outlook Express,Microsoft Express. Hòm thư webmai của Google (Gmai ) hay Yahoo 

cũng hỗ trợ giao thức POP3 (nhưng Yahoo chỉ dùng được tính năng này ở bản đóng phí). 

 

a. Thêm một trang bìa 

Word 2010 cung cấp sẵn cho bạn một bộ sưu tập các trang bìa khá đẹp mắt. Các trang bìa luôn 

được chèn vào đầu tài liệu, không phụ thuộc vào vị trí hiện tại của con trỏ trong tài liệu. 

- Trong thẻ Insert, nhóm Pages, bạn nhấn nút Cover Page. 

- Trong menu xuất hiện, bạn hãy nhấn chọn một kiểu trang bìa mình thích. Trang bìa đó sẽ được 

áp dụng vào tài liệu và bạn có thể sửa đổi nội dung các dòng chữ mặc định bằng dòng chữ mình 

thích. 

 

b. Xóa trang bìa 

Để xóa trang bìa, bạn nhấn chuột vào thẻ Insert, nhấn nút Cover Page trong nhóm Pages, sau đó 

nhấn Remove Current Cover Page. 

4. Tìm nhanh từ đồng nghĩa trong Word Tra từ đồng nghĩa, phản nghĩa 

Sử dụng tính năng Research, bạn còn có thể tra từ đồng nghĩa và từ phản nghĩa. 

- Trong thẻ Review, nhóm Proofing, bạn nhấn nút Thesaurus. 

 

- Giữ phím Alt và nhấn chuột vào từ cần tra. Kết quả sẽ hiển thị trong khung Research ở bên 

phải. 

http://bikipvanphong.info/tag/microsoft/
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- Để chèn từ đồng nghĩa hoặc phản nghĩa đó vào tài liệu hiện hành, nơi con trỏ đang đứng, bạn 

đưa chuột vào từ trong danh sách kết quả, nhấn chuột vào mũi tên bên cạnh từ, chọn Insert. 

- Để tìm tiếp từ đồng nghĩa / phản nghĩa của từ trong danh sách tìm được, bạn nhấn chuột vào từ 

đó trong danh sách kết quả. 

Ghi chú: Bạn có thể tìm từ đồng nghĩa, phản nghĩa trong ngôn ngữ khác (ngoài tiếng Anh) bằng 

cách nhấn chuột vào hộp danh sách bên dưới khung nhập liệu Search for và chọn một ngôn ngữ, 

ví dụ như tiếng Pháp (French) chẳng hạn. 

5. Gởi file qua Email từ môi trường Word 

Dù vẫn hay mở hòm thư, chọn chức năng tạo mới rồi đính kèm file văn bản để gởi cho đối tác, 

bạn có thể thay đổi thói quen này bằng cách gởi ngay trên môi trường Word. 

Điều kiện là máy tính của bạn đã cài Outlook Express hoặc Microsoft Express. 

http://bikipvanphong.info/wp-content/uploads/2012/07/huong-dan-tao-trang-bia-trong-word-2010-3.gif
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Khi có hòm thư e-mail do một máy chủ hỗ trợ (theo giao thức IMAP hoặc POP3), bạn có thể 

dùng Outlook Express, Microsoft Express. Hòm thư webmai của Google (Gmai ) hay Yahoo 

cũng hỗ trợ giao thức POP3 (nhưng Yahoo chỉ dùng được tính năng này ở bản đóng phí). 

Các bước thực hiện như sau: 

- Mở một tập tin muốn gởi 

- Vào menu File → Share → Send Using E-mail. Chọn tiếp một kiểu để gởi email. 

Như đã nói ở trên, lệnh này chỉ thành công khi Word phát hiện một hệ thống e-mail tương thích 

và hoạt động khi các chương trình đó đã được cài đặt. 

- Lúc này giao diện gởi thư hiện ra với các dạng như To…, CC…., Subject… Nếu không nhớ e-

mail của người gởi, bạn nhấn vào biểu tượng hình quyển vở để đọc sổ địa chỉ và chọn OK. 

- Biểu tượng có dấu mũi tên màu xanh và dấu chấm than sẽ giúp bạn đặt e-mail gởi đi của mình 

ở cấp độ ưu tiên nào (thấp, bình thường, cao). Bạn cũng có thể đính kèm các file khác ngay trên 

môi trường Word bằng cách nhấn vào biểu tượng chiếc kẹp ghim. 

- Sau đó, nhấn vào mục Send a copy. 

Chú ý rằng vào lần đầu tiên gởi thư theo cách này, có thể bạn sẽ được yêu cầu nhập ID, password 

và domain. Lúc này, bạn chỉ cần gõ lại đúng như khai báo đối với hòm thư Outlook hoặc 

Microsoft Express đã tạo trước đó. 

6. Thủ thuật dùng máy tính trong Word 

Mặc dù công năng chính của Microsoft Word là soạn thảo văn bản, song nó cũng cho phép người 

dùng thực hiện các phép tính cơ bản thông qua chiếc máy tính làm được tích hợp với tên gọi 

http://bikipvanphong.info/wp-content/uploads/2012/07/huong-dan-tao-trang-bia-trong-word-2010-4.gif
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Tools Calculate (khá giống với tiện ích Calculator trong thư mục Accessories của hệ điều hành 

Windows). 

Để khai thác công cụ bí mật này của Microsoft Word, trước tiên, bạn cần đặt biểu tượng Tools 

Caculate của nó trên tab mới của cửa sổ soạn thảo văn bản bằng cách: 

Tạo Tab mới trên Ribbon: click phải lên Ribbon, chọn Customize the Ribbon: 

 

Hộp thoại Word Options hiển thị. 

 

Chọn New Tab, lần lượt đổi tên thành Tab Caculator, và group Tinh Toan 

Ở cột Choose commands from, chọn All commands, di chuyển thanh cuốn chọn Tools Calculate. 

Nhấn nút Add để thêm vào biểu tượng vào Tab Caculator 

Kế tiếp, bạn hãy nhập vào một phép tính, chẳng hạn ((90+10)*2)/50. Hãy đánh dấu khối phép 

tính này rồi nhấp chuột lên nút Tools Calculate. Kết quả của phép tính sẽ được trình bày ở góc 

dưới trái của cửa sổ soạn thảo văn bản (nằm ngay sau dòng chữ The sesult of the calculation is). 

http://bikipvanphong.info/wp-content/uploads/2012/07/huong-dan-tao-trang-bia-trong-word-2010-5.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/huong-dan-tao-trang-bia-trong-word-2010-6.gif
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7. Thủ thuật tránh in văn bản ngoài ý muốn 

Có thể hàng ngày bạn vẫn soạn thảo tài liệu bằng chương trình Word, nhưng vì yêu cầu an toàn 

thông tin mà bạn tuyệt đối không được in ra một khi chưa cần thiết. Tuy nhiên, chức năng Print 

trên thanh công cụ của Word luôn thường trực sẵn sàng để thực hiện lệnh in cho dù bạn nhỡ tay 

bấm nhầm. 

Để khống chế chức năng in tức thời không cần xác nhận của Word, bạn có thể thiết lập tùy chọn 

thông báo trước khi thi hành lệnh in. Tùy chỉnh này rất cần thiết trong trường hợp bạn thường 

xuyên xử lý hay xem lại những trang tài liệu bí mật nhất là trong văn phòng sử dụng máy in nối 

mạng. 

Trước hết bạn cần nhấn vào nút Office có biểu tượng đặt tại góc đỉnh phía trái màn hình. Chọn 

nút Word Options, kế tiếp chọn Trust Center trong danh sách, rồi chọn nút Trust Center Settings 

 

Và nhấn vào Privacy Options. Sau đó nhấn chuột đánh dấu mục Warn before printing… và bấm 

nút OK. 

http://bikipvanphong.info/wp-content/uploads/2012/07/huong-dan-tao-trang-bia-trong-word-2010-7.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/huong-dan-tao-trang-bia-trong-word-2010-8.gif
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Ngoài ra còn có một cách định dạng khác đối với những tài liệu mang nội dung riêng tư, đơn 

giản đó là giải pháp không cho in văn bản ra giấy. Bạn cần lựa chọn toàn bộ trang văn bản 

(Ctrl+A), sau đó bấm nút chuột phải và chọn mục Font trong trình đơn thả, đánh dấu vào mục 

Hidden rồi ấn nút OK. 

 

Kết thúc bước này, nội dung văn bản của bạn đã được ẩn đi. Để hiện lại trên màn hình, bạn vào 

Tab File/Options, nhấn đánh dấu mục Hidden text sau đó đừng quên nhấn nút OK. 

http://bikipvanphong.info/wp-content/uploads/2012/07/huong-dan-tao-trang-bia-trong-word-2010-9.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/huong-dan-tao-trang-bia-trong-word-2010-10.gif
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Hoàn thành bước này, toàn bộ nội dung văn bản hiển thị trở lại trên màn hình tuy nhiên nếu in 

bạn sẽ chỉ được kết quả là trang giấy trắng. 

8. Mẹo in hình khổ giấy lớn bằng máy in nhỏ 

Bạn có một máy in màu chỉ in được cỡ giấy A4 nhưng lại muốn in ra những tấm ảnh có kích 

thước ―khổng lồ‖ để trang trí trong gia đình? Công cụ mang tên ―The Rasterbator‖ sẽ giúp bạn 

thực hiện điều tưởng như bất khả thi này. 

 

Chương trình sẽ khéo léo ―cắt‖ tấm ảnh số của bạn ra thành rất nhiều phần nhỏ bằng nhau với 

kích thước của mỗi phần bằng đúng khổ giấy A4. Bạn chỉ việc in ra toàn bộ những phần này, sau 

http://bikipvanphong.info/wp-content/uploads/2012/07/huong-dan-tao-trang-bia-trong-word-2010-11.gif
http://bikipvanphong.info/wp-content/uploads/2012/07/huong-dan-tao-trang-bia-trong-word-2010-12.gif
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đó ghép lại với nhau cho chính xác như trò chơi ghép hình của trẻ em và dán lên một nơi nào đó 

đã chuẩn bị sẵn, bạn sẽ có một tấm ảnh ―to đùng‖ không thua kém gì lắm so với các poster quảng 

cáo. 

Sau khi chọn ngôn ngữ cho mình, thường là tiếng Anh, bạn nhấn vào ―Continue‖ để vào các 

bước: 

Nhấn vào ―Browse‖ để tìm đến bức ảnh cần in rồi nhấn ―Open‖ để hiện ra đường dẫn đến tấm 

ảnh rồi nhấn ―Continue‖. 

Chọn khổ giấy của máy in → nếu tấm ảnh là khổ đứng thì chọn ―Portrait‖, nếu là khổ ngang thì 

chọn ―Landscape‖. 

Ở ô ―sheets‖, bạn thoải mái lựa chọn số tờ mà bạn cần ―The Rasterbator‖ cắt ra cho mình. Lưu ý 

số tờ càng nhiều thì tấm ảnh của bạn càng lớn và có thể đến mức khổng lồ. Nên tính toán kỹ mặt 

bằng dán ảnh trước khi ra lệnh cho ―The Rasterbator‖ cắt hình. Số tờ tối đa mà ―The 

Rasterbator‖ có thể cắt cho bạn là đến 1.000 tấm, đủ sức tạo nên một bảng quảng cáo kinh 

khủng! 

Bản mới nhất của chương trình là ―Rasterbator Standalone 1.2″ có thể tải miễn phí tại 

http://arje.net/files/Rasterbator_Standalone_1.21.zip dưới dạng file nén ZIP có dung lượng 866 

KB. Khi tải về máy xong, bạn chỉ việc bung thư mục chứa chương trình vào ổ cứng và nhấp đúp 

vào file Rasterbator.exe để chương trình tự động chạy. 

9. Tạo nhanh một hoặc nhiều dòng ngẫu nhiên 

Nhằm phục vụ cho việc tạo ra một dòng, một trang hay nhiều trang trong word để có thể kiểm tra 

việc in ấn dễ dàng. Chúng ta có thể nhập vào dạng công thức sau: =lorem() thì mặc định với 3 

đoạn, 6 dòng hoặc =lorem(số đoạn cần in ra, số dòng trên mỗi đoạn). Bên cạnh đó bạn có thể 

dùng lệnh rank với cú pháp tương tự như lệnh lorem. 

10. Tạo bảng bằng phím 

Bằng sự kết hợp giữa phím ―+‖ và ―-‖, phím Enter và phím Tab tr n bàn phím, chúng ta có thể dễ 

dàng và nhanh chóng tạo ra các bảng tính. Giả sử, bạn cần tạo một bảng tính 4 cột và có 4 dòng, 

bạn thực hiện như sau: Đầu tiên bạn nhấn +—-+—-+———– –+———+ sau đó nhấn Enter ở 

cuối dòng. Một bảng tính được xuất hiện, tiếp theo, bạn đặt con trỏ chuột ở cột cuối cùng và 

nhấn Tab, một dòng mới sẽ xuất hiện. Độ rộng của bảng tính chính bằng số dấu ―-‖ mà bạn đã 

nhấn lúc tạo bảng. Tuy nhiên bạn có thể thay đổi độ rộng này khi nhập liệu. 

11. Tạo đường kẻ 

http://bikipvanphong.info/quang-cao/
http://bikipvanphong.info/quang-cao/
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Để tạo nhanh các đường kẽ ngang của một trang tài liệu, bạn chỉ cần sử dụng các đặc biệt có trên 

bàn phím. Các phím -, =, *, #,~ khi được nhấn tương ứng từ 3 phím mỗi loại trở lên sẽ tạo ra 

đường kẻ đơn, đôi, ba, đường chấm đứt nét và đường dzíc dzắc. Khi đó bạn không cần phải vào 

danh mục trên Ribbon để thực hiện. Ví dụ để tạo đường kẽ đôi, bạn chỉ cần nhấn === và nhấn 

enter là xong. 

12. Bỏ tính năng tự động SuperScript 

Thông thường, khi bạn gõ vào ngày theo kiểu anh hoặc những ký tự tương tự như 1st, 

2nd,…,7th, thì Word sẽ tự động SuperScript ký tự đó thành 1st, 2nd, ,7th, .Nếu bạn không muốn 

vậy, sau khi gõ xong mỗi cụm ký tự, bạn nhấn Ctrl +Z để Word bỏ áp dụng thiết đặt đối với cụm 

ký tự đó. Nếu bạn muốn áp dụng đối với toàn bộ các cụm ký tự cho văn bản thì bạn hãy vào biểu 

tượng Office ở góc trên – bên trái, sau đó chọn Word Options. Tiếp theo bạn chọn mục Proofing 

và chọn AutoCorrect Options. Trong cửa sổ AutoCorrect bạn chọn tab AutoFormat As You Type 

và check bỏ mục chọn Ordials(1st) with superscript như hình. 

13. Copy định dạng bảng tính 

Bạn vừa định dạng một ô trong bảng tính và có nhiều ô cần bạn định dạng giống như vậy. Bạn có 

thể di chuyển chuột để sử dụng chức năng Format Painter, nhưng điều đó sẽ tốn nhiều thời gian. 

Hãy định dạng một ô trong số những ô bạn cần định dạng và di chuyển chuột đến một vị trí cần 

sao chép định dạng, quét khối ô này và nhấn F4. Thế là định dạng mới sẽ được thiết đặt. 

 

 

 

BÀI 6: 

Ở đây, tôi thực hiện trên Microsoft Office 2010, nếu dùng Microsoft Office 2007 hay cũ hơn thì 

sẽ có một chút sai khác, bạn hãy dùng các lựa chọn tương đương để làm. 

Đây là điều tối cần thiết, để bạn tiết kiệm được thời gian mỗi khi tạo một văn bản mới cũng như 

để cho văn bản có hình thức phù hợp. Đầu tiên, bạn vào thẻ File > Options để mở Word Options 

lên. 

http://bikipvanphong.info/tag/microsoft/
http://bikipvanphong.info/tag/microsoft-office-2/
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1. THIẾT LẬP MÔI TRƯỜNG LÀM VIỆC 

http://bikipvanphong.info/wp-content/uploads/2012/08/thu-thuat-hay-trong-MICROSOFT-WORD-1.jpg
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Bạn chọn Advanced rồi tại phần Display bạn bấm vào mũi tên ở Show measurements in units 

of bạn chọn Centimetershay Milimeters tùy vào thói quen, trong ví dụ này sẽ chọn Milimeters. 

 

Tiếp theo, bạn vào Save rồi tại Default file location bạn bấm Browse để chọn thư mục bạn 

thường xuyên làm việc nhất. Để tránh các sự cố đáng tiếc thì thư mục này không nên đặt ở ổ đĩa 

cài đặt Windows (thông thường là ổ C:). Save files in this format là nơi bạn có thể thay đổi định 

dạng mặc định Word 97-2003 Document (*.doc) để lưu tập tin thay cho .docx. Tuy nhiên, chỉ 

khi thường xuyên đọc tập tin trên các máy tính không cài đặt Microsoft Office 2007/2010 thì bạn 

mới đổi vì ở định dạng này một số tính năng sẽ bị vô hiệu hóa. 

http://bikipvanphong.info/wp-content/uploads/2012/08/thu-thuat-hay-trong-MICROSOFT-WORD-2.jpg
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Một điểm hay gặp khi soạn thảo văn bản là các ―lăn quăn‖ chạy dưới chân chữ, mặc dù khi in 

văn bản thì các đường này không có nhưng thật sự làm bạn cảm thấy khá khó chịu vì nhìn văn 

bản rối hơn. Đây chính là tính năng cảnh báo đối với từ ngữ sai chính tả, tuy nhiên hiện 

Microsoft Office vẫn chưa hỗ trợ tiếng Việt; bạn có thể vô hiệu hóa bằng cách vàoProofing rồi 

tại phần When correting spelling and grammar in Word bạn bỏ dấu chọn ở Check spelling as 

you type, Mark grammar errors as you type và Check grammar with spelling. Xong, bạn 

bấm OK để lưu lại tất cả các lựa chọn đã thực hiện từ đầu. 

http://bikipvanphong.info/wp-content/uploads/2012/08/thu-thuat-hay-trong-MICROSOFT-WORD-3.jpg
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Trở ra, bạn vào thẻ Page Layout và bấm  ở nhóm Page Setup. 

 

Tại thẻ Margins bạn đặt các canh lề trong phần Margin, thông thường bạn có thể thiết lập 

ở Top (lề trên), Bottom (lề dưới) khoảng 20-25 mm, Left (lề trái) từ 30-35 mm và Right (lề 

phải) từ 15-20 mm. Khi có quy định đặc biệt hay tùy vào bố trí trang mà bạn thay đổi cho phù 

hợp. Để đặt canh lề mặc định, bạn bấm Set As Default. 

http://bikipvanphong.info/wp-content/uploads/2012/08/thu-thuat-hay-trong-MICROSOFT-WORD-4.jpg
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Bạn chọn Yes trong thông báo của Microsoft Word rồi bấm OK để hoàn tất việc canh lề mặc 

định cho trang. 

Bước cuối cùng là bạn 

chọn font chữ mặc định bằng cách vào thẻ Home rồi tại nhóm Font bạn bấm . Để thao tác 

nhanh hơn, bạn nên ghi nhớ tổ hợp phím tắt Ctrl + D. 

http://bikipvanphong.info/wp-content/uploads/2012/08/thu-thuat-hay-trong-MICROSOFT-WORD-6.jpg
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Bạn vào thẻ Font rồi tại phần Font bạn chọn font chữ mặc định, chọn kiểu tại Font style và 

chọn cỡ chữ tại Size. 

 
Để những lựa chọn trên là mặc định, bạn bấm Set As Default rồi đánh dấu vào All documents 

based on the Normal template và bấm OKhai lần để hoàn tất. 
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2. CHÈN NHANH KÝ TỰ ĐẶC BIỆT VÀO VĂN BẢNViệc chèn ký tự đặc biệt được thực 

hiện qua lựa chọn Insert của Microsoft Word, tuy nhiên với những ký tự toán học bạn có thể 

chèn nhanh hơn bằng cách sử dụng công cụ AutoCorrect. Để khai thác tính năng này, bạn vào 

Word Options rồi chọn Proofing và bấm AutoCorrect Options. 

 
Tại thẻ Math AutoCorrect bạn đánh dấu vào Use Math AutoCorrect rules outside of math 

regions, và xem lại Replace text as you type cũng đã được chọn hay chưa. Khi nhập nội dung 

tương ứng ở cột Replace thì sẽ được thay thế bằng giá trị ở With, bạn cần phải ghi nhớ điều này. 

Nhìn chung, cách nhập liệu cũng khá đơn giản, ví dụ khi bạn gõ alpha sẽ được thay thế bằng 

α, beta sẽ thành β. 
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Muốn sửa dòng nào, bạn nhập lại nội dung cho dòng đó ở Replace và bấm Add.
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Để thêm mới, bạn chèn ký 

tự đó vào văn bản và copy vào bộ nhớ clipboard rồi sau đó truy cập vào Math AutoCorrect. 

Lúc này, tại With đã có sẵn ký tự bạn vừa copy, nhập nội dung đại diện vào Replace rồi 

bấm Add để thêm. 

 

 

 

BÀI 7 

Có thể khi sử dụng Office 2003 bạn đã từng thao tác tạo mục lục tự động nhưng sang đến phiên 

bản 2010 thì cách thức sử dụng sẽ khác hơn. Ở phần này chúng tôi sẽ hướng dẫn bạn chi tiết hơn 

về điều này. 

1. CÁCH TẠO MỤC LỤC CHO VĂN BẢN 
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Với những văn bản được chia làm nhiều chương mục như báo cáo, tiểu luận, luận văn,…thì việc 

tạo mục lục sẽ rất cần thiết. Để tạo mục lục, bạn bắt đầu từ việc tạo một style bằng cách vào thẻ 

Home và bấm  ở nhóm Styles. 

 

Trong danh sách của Styles, bạn bấm  (New Style). 

 

Bạn đặt tên cho style tại Name, ở Formating bạn chọn font chữ, cỡ, kiểu, màu chữ, canh lề,… 
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Tiếp theo, bạn bấm vào nút Format > Numbering để chọn hình thức đánh số. 
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Trong thẻ Numbering bạn chọn kiểu đánh số đề mục ở Numbering Library rồi bấm OK. Nếu 

muốn định nghĩa một kiểu mới thì bạn bấm vào Define New Number Format và thực hiện. 
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Trở ra, bạn bấm Format lần nữa và chọn Paragraph để thiết lập canh lề, tại thẻ Indents and 

Spacing bạn canh lề trái, phải lần lượt ở Left và Right, đồng thời chọn cách dòng ở Special rồi 

bấm OK. Để hiểu rõ về các lựa chọn ở đây, bạn nên làm thử nghiệm và xem trước. 
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Cứ thế, tùy theo số lượng đề mục mà bạn tạo số lượng style tương ứng. Bước tiếp theo, bạn bôi 

đen phần tiêu đề muốn gán style rồi tại nhóm Styles bạn chọn kiểu theo nguyên tắc các tiêu đề 

cùng cấp (ví dụ I, II, III hay 1, 2, 3) sẽ có cùng style. Đề mục sẽ được định dạng như bạn đã chọn 

khi tạo style và tự động đánh số thứ tự. 

 

Khi đã quen và hiểu về nguyên lý làm việc, bạn có thể không cần tạo style mới nữa mà hãy bấm 

chuột phải vào Heading 1, Heading 2 hay Heading 3 và chọn Modify rồi thực hiện sửa lại theo ý 

mình. 
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Muốn chèn mục lục, bạn đưa chuột đến vị trí cần chèn (đầu hoặc cuối văn bản) rồi vào thẻ 

References, trong nhóm Table of Contens bạn bấm Table of Contens và chọn Automatic Table 1 

hoặc Automatic Table 2. Nếu các kiểu đã chọn không làm bạn hài lòng thì hãy chọn Insert Table 

of Contents. 

 

Khi có nhiều cấp đề mục quá sẽ dẫn đến mục lục khá dài, bạn có thể giảm bớt bằng cách chỉ định 

số cấp tại Show levels. Muốn lấy mục lục từ những style nhất định nào đó, bạn bấm Options. 
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Bạn xóa giá trị TOC level ở cấp đề mục mà không muốn làm mục lục rồi bấm OK hai lần để 

chèn mục lục. 

 

Khi có sự thay đổi về đề mục, bạn đưa chuột vào vùng chứa mục lục rồi bấm chuột phải > 
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Update Field. 

 

Nếu chỉ có thay đổi về số trang, bạn chọn Update page numbers only rồi bấm OK, nếu có thay 

đổi ở đề mục thì bạn chọn Update entire table để làm mới hoàn toàn mục lục. 

 

 

 

BÀI 8: 

Khi văn bản chứa nhiều hình, bản biểu thì việc đánh số thủ công sẽ rất tốn thời gian, nhất là khi 

có sự điều chỉnh. Vậy sao bạn không thực hiện việc đánh số tự động để nâng cao hiệu quả công 

việc. Phần này sẽ giúp bạn các thao tác đánh số và tạo mục lục cho bảng biểu, hình vẽ. Ngoài ra 

phần này còn hướng dẫn bạn cách tạo ra các nút check box phục vụ cho mục đích thăm dò. 

 

4. ĐÁNH SỐ VÀ TẠO MỤC LỤC CHO HÌNH, BẢNG BIỂU 

Khi văn bản chứa nhiều hình, bản biểu thì việc đánh số thủ công sẽ rất tốn thời gian, nhất là khi 

có sự sự điều chỉnh. Vậy sao bạn không thực hiện việc đánh số tự động để nâng cao hiệu quả 

công việc. Cách làm khá đơn giản, đầu tiên bạn bấm chọn bảng hay hình sẽ đánh số rồi vào thẻ 

References, tại nhóm Captions bạn bấm Insert Caption. 

 

Trong hộp Caption bạn bấm New Label. 
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Bạn nhập tên của nhãn (Hình, Bảng) vào rồi bấm OK. 

 

Trở ra, bạn chọn vị trí chèn tại Position là Below selected item đối với hình (chèn dưới hình) và 

với bảng thì chọn Above selected item (chèn trên bảng) rồi bấm OK để chèn, sau đó nhập chú 

thích vào. 

 

Kể từ lần thứ hai trở đi thì bạn chỉ cần chọn vào đối tượng rồi bấm Insert Caption và chọn OK để 

chèn. Nếu thực hiện cho cả bảng và hình thì bạn tạo hai nhãn khác nhau và thêm bước chọn 

Bảng hay Hình ở Label. 
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Muốn tạo mục lục cho hình, bảng thì bạn đặt trỏ chuột đến vị trí muốn chèn rồi vào thẻ 

References, tại nhóm Captions bạn bấm Insert Table of Figure. 

 

Ở Caption label bạn chọn nhãn (nếu tạo nhiều nhãn) rồi bấm OK. Việc cập nhật cho mục lục này 

tương tự như đã trình bày. 
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5. CÁCH TẠO PHIẾU THĂM DÒ 

Để tạo phiếu thăm dò bằng Microsoft Word, bạn vào thẻ File > Options để mở phần tùy chọn 

lên. Bạn chọn Customize Ribbon rồi đánh dấu vào Developer ở phần Customize the Ribbon và 

bấm OK. 
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Bạn nhập câu hỏi rồi đưa chuột đến vị trí đặt dấu check rồi sau đó vào thẻ Developer, ở nhóm 

Controls bạn bấm vào nút sẽ có danh sách nút lệnh xổ ra và bạn chọn . 

 

Khi đã chèn xong, cũng trong thẻ Developer bạn bấm Restrict Editing ở nhóm Protect. Khi đó 

phía bên phải trang sẽ xuất hiện panel, tại phần Editing restrictions bạn đánh dấu chọn Allow 

only this type of editing in the document và ở danh sách bên dưới bạn chọn Filling forms. Tiếp 

đó, bạn bấm Yes, Start Enfording Protection. 
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Bạn nhập mật khẩu bảo vệ vào các trường Enter new password (optional) và Reenter password 

to confirm rồi bấm OK. Microsoft Word cho phép bỏ trống phần này nhưng bạn nên nhập để 

tránh có sự thay đổi nội dung khi thực hiện khảo sát. 

 

Lúc này, người xem chỉ có thể thực hiện đánh dấu vào các lựa chọn của bạn đưa ra. 
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